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LCCS/LCAP Beginners Computer Classes 

Introduction  

Purpose 
The purpose of this course is to give the student a basic understanding of 
how to use the Windows operating system.  The course focuses on 
developing mouse skills, using CDs and floppies, creating files and folders, 
making shortcuts to files and programs, manipulating windows, 
understanding email, surfing the internet, and maintaining the computer. 

The Course 
 The course consists of seven weekly classes with each class  

lasting two hours.  Zerger Hall Senior Center — 345-0821.  Please 
phone if you cannot make your scheduled class. 
Upon the completion of this course the student should be able to: 

• Turn on and shutdown the computer  
• Control and use the mouse 
• Open and close files  
• Create and save a folder and/or a file   
• Create and send email  
• Utilize the internet 
• Perform basic maintenance 
• Load, retrieve and copy information from CDs and Floppies  

to and from your computer 

Prerequisite  
There are no skill perquisites for taking this course.  It is a course 
that starts with the very basics of computing.  It would be helpful, but 
not essential, to have typing knowledge. We insist, however, that you 
have a computer to use and practice with at home. Otherwise, what 
you learn in class will be quickly lost. 

Course Computers and Personnel  
The Licking County Computer Society (LCCS) provides the 
computers and projector for the classroom and maintains them.  All 
personnel who help manage and teach the class sessions donate their 
time as volunteers from LCCS.  The Licking County Aging Program 
(LCAP) provides the room, tables, support from staff, and makes 
other facilities available to us.

Introduction 
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Week 1 
 

A.  Introduction 
 

1.  Please DO NOT turn on computers. 
2.  Name cards. 
3.  Sign in sheet 

a. Fill out your name, address, and birth date, along with the last 4 
numbers of your Social Security number.  This is for the Licking 
County Aging Program (LCAP) to help with their funding purposes. 

b. Check your name on the sheet each week to indicate attendance. 
4.    Handouts 

a. The Instructors and aides — this handout is for students so that if 
they have a computer question or problem, the student can call an 
instructor or aide for help.  Please only call between 9:00 AM and 
9:00 PM. 

b. Course outline — a course outline is in your notebook and is 
yours to keep.  It  covers the instructions that will be presented in 
each week’s class of the course.  Please take the outline home with 
you for practice and bring it back to class each week. 

c. CD containing all the class materials. If you do not have a CD drive 
on your computer at home, we will give you a set of floppy disks with 
the essential materials. 

d. Quizzes to take home — answers for each week will be discussed at 
the beginning of the following week.   

e. Additional handouts — from time to time, there will be additional 
handouts covering information for specific classes. 

5 .  Questions and answers 
a.  General student knowledge (typing ability, etc.) 
b.  Student’s computers at home — it is essential that you practice at home.   
c.  Operating system — Windows 98, Me, or XP.  We will be using 

Windows XP in the classroom.  If you have Windows 98 or Me, we 
will give you an extra outline to use at home. 
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B. Hardware Explanations — presentation by the instructor. 
Watch the illustrations on the screen.  (The instructor may at times “freeze” your 
monitor so that your screen shows what is projected.  In this case, do not try to use 
your mouse or keyboard.)   

1. In the tower (Figure 1): 
a. Pentium processor 
b. RAM Random Access Memory. 
c. Hard disk drive (commonly called C Drive)  
d. Sound card, display adapter, modem 
e. CD - ROM — large data storage capacity 
f. Modem or local area network (LAN) 
g. Floppy drive — small data storage capacity  

2.  Peripherals 
a. Power strip with filtering and surge protection (Figure 2) 
b. Monitor 
c. Mouse 
d. Keyboard  
e. Printer and automatic ABCD switch 
f. Other (not attached to classroom computers — scanner, multicard 

reader, etc. 
 
C. Software   

While hardware refers to anything you can physically touch, it cannot act 
without instructions.  Some instructions are “hard-wired” but software 
provides the main ingredients that allow the user to run the computer and use 
applications to accomplish simple and complex tasks.  Software is usually 
stored on magnetic media such as the hard drive. It can be divided into two 
main categories.  
1. Operating system 

The operating system controls the workings of the computer.  In the case 
of our computers, Windows XP is the operating system and also includes 
some small application programs.    

2. Program Applications 
Program applications allow the user to perform a multitude of tasks.  
Common ones are word processing, calculations, use of pictures 
(graphics) including digital photos, database, etc.   
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On each table, there is one 
power strip serving the two 
computers. It is attached to a 
back leg of the table nearest the 
wall.  The On/Off switch has a 
zero (off) and a one (on).  A 
small indicator light will show 
when the power is on. 
.  
It is important that the strip 
should never be turned off 
until both computers on the 
table have been powered down 
by following the instructions 
on page 5 of the outline for 
week 1 under D. 2.



 

Figure 3.  User accounts. These screens will be seen when starting Windows in the 
classroom.  There are separate accounts for each of the beginner’s classes and others for 
the various groups using these computers. The icons may differ from those seen on your 
computer. The system account is numbered for each computer and is the only one that is 
not restricted.  You may have to scroll down to see your own class.  Scroll using the 
scroll wheel on the mouse or by clicking on the tiny arrow at the bottom of the scroll bar 
(right-hand side of each picture). 

To check if you are in the correct user account, press the Window key on the 
keyboard — a menu comes up with the account name (class name) on top. 

 

 

 

 

 

 

 
Figure 4.  

Overview of Windows Desktop.  See page 5 of the outline for week 1 under E. The 
background and how many icons appear on the Desktop are the user’s choice.  The Quick 
Launch area of the Task Bar holds icons that require only one click for launching 
programs.  The system tray shows icons of programs running at start-up.  

Week 1, Page 4 
 



 

Week 1, Page 5 
 

D.     Starting and exiting Windows   
1. Turning on your computer 

a. Be sure power strip is on. 
b. Turn on monitor and then turn on the computer  

 WHAT YOU SHOULD SEE ON STARTING UP 
i. Dell logo 
ii.  Windows XP — Home  (Professional in display computer)
iii.  Blank screen   
iv. Welcome 
v. User accounts (Figure 3) — click on your class 
vi.  Type in your class code 
vii. Desktop  (icons etc) — Figure 4 
viii. To check if you are in the right user account, click on Start 

button. Name is at the top. 
2.    Turning off the computer 

a. DO NOT turn the computer off by using the on-off button on 
the tower. 

b. Using the mouse, place the arrow on the Start button and click on the 
words Turn Off Computer. Options are then displayed on the 
Screen. 

c. Click on the middle button (red, Turn off).   Follow screen 
directions.  The computer will turn off by itself after a short delay.  
Ask for help if it does not. 

d. Turn off the monitor and then the power strip (be sure both computers 
on the table are off). 

e. Before turning the computer back on, always wait 20 seconds (safety 
precaution for the C Drive to stop).  
 

1.  Exercise – Repeat steps under 1 and 2 above, leaving out step 2.d 
 

E.  Overview of Windows Desktop 
What you see on the screen after Startup is the Windows user interface.  
(Figure 4) 
1.  ICONS seen on the screen at startup 
2.  Task bar 
3.  Quick launch area 
4.  System tray   
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F.  Using the Mouse  
A mouse is a handheld input device you roll across a flat surface (like a desk 
or mouse pad).  The mouse pointer is the arrow or symbol that indicates the 
mouse pointer’s position on the desktop.(of the computer) 

1.  How to hold the mouse — (watch the instructor).  

    
 

Figure 5.  How to hold the mouse.  Place your hand gently on the mouse (left-
hand photo) with your thumb and 3rd and/or 4th fingers on the table (best seen in 
the overhead photo at the right). This gives you control of mouse movement. 
 

2.   To position the mouse you move the mouse and the pointer moves in 
the same direction that you move the mouse.  
Once you move the mouse to a desired position on the desktop you use 
the mouse buttons - left or right to tell it what to do. 

3.  A typical Mouse    
A mouse normally has two mouse buttons and a scroll wheel.  You use 
the left button to click choices, select text, and drag items around the 
screen.  When you click an item with the right button such as text or 
a graphic, a short menu appears with a list of commands related to the 
selected item.  The scroll wheel is used to page up or down.
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4.  Understanding Basic Mouse Techniques 
a. Pointing — Move the mouse to position it over an item on the 

desktop 
b. Clicking — Press and release the left button 
c. Double-Clicking — Press and release the left mouse button twice 

quickly 
d. Dragging — Point to an item, press and hold the left mouse button 

down, move the mouse to a new location, and then release the mouse 
button. 

e. Right-clicking — Point to an item, and then press and release the 
right mouse button and you then get a menu.  You then click a 
command from the menu. 

f. Right-dragging — position the mouse cursor over an item, hold the 
right button down and move it to a new position.  When you release 
the button, a menu appears.  You can then click on a command. 

 
 
 
 
 
 
Please note:  If the instructions say click or drag, it 
means use the left button.  Otherwise, the 
instructions will say right click or right drag.  
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Figure 6.  Mouse settings..  If you need to make changes to how your mouse performs at 
home, here is a brief description. 
To open Mouse properties, click Start, click Control Panel, and then double-click 
Mouse.  The dialog box (above) appears. Depending upon your specific mouse, options 
may vary from the illustration. In general, the following options are available. 
1) Adjust the double-click speed for your mouse.  2) Adjust the cursor blink rate .   
3) Reverse your mouse buttons (e.g. if you are left-handed).  4) Improve the visibility of 
the mouse pointer.  5) Change the appearance of your mouse pointer.  5) Adjust the 
speed of your mouse pointer.  6) Change the number of lines that you scroll with the 
center scroll wheel.  
If you need more help, go to Help from the Start menu and search for “Mouse settings”. 
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G.  Using the game of Solitaire to practice using the mouse. 
a. Click on the Start button, then click on All Programs. 
b. Click on Games (Figure 7). 
c. Click on the word, Solitaire.  The program opens in a window.  If you 

do not know how to play the game, click on Help in the menu bar 
near the top of the window, just below the title bar.  Choose the Index 
tab and click on how to play the game.  Just read what comes up on 
the screen. 

d. Close the program after you have practiced, but be sure to practice at 
home! 

 

 
 
Figure 7.  How to open (launch) the game of Solitaire.  This is what 
your screen should show just before you click on the word, Solitaire.   



 

  
 

Special Instructions 
 

Copying Student Files from a floppy disk or a CD to a folder in My 
Documents. 
These steps are essential for subsequent weeks, when we will be using the files for 
exercises during the rest of the course.  We will give each student a floppy disk or 
CD, depending on what is needed for his/her home computer.  

1.  Making a folder in My Documents 
a. Open My Documents (on the desktop, double click on the icon, My 

Documents).  
b. Right click in the blank (clear) portion of the window.  On the menu 

that appears, click on New and then on Folder in the next menu. 
c. While the folder caption is dark, type Your name.  Then click on a 

clear area.  
d. Open the folder you just made by double clicking on it, or single 

clicking and pressing the Enter key.  Leave the window showing on 
the Desktop. You know you are in your folder by the title bar name.   

2.  Use of Floppy or CD Disk 
a. Insert the disk into the Floppy drive with the arrow pointing up and 

in the direction of the drive. Or — Insert the CD in the top CD-ROM 
drive with the label up.   

b. From the Start menu or from the Desktop, open My computer, and double 
click on 3 ½ floppy drive (A:) or on the CD drive (D:). 

c.  You should see a folder named Student files.   
d. Make sure this window and the Your folder window are both 

showing on the Desktop. To do this, right click on the taskbar and 
choose tile vertically. Right drag the folder Student files to Your 
folder window and, in the new menu, choose Copy with a left click. 

e. You now have a subfolder in Your folder, which, in turn, is a 
subfolder of My documents. 

f. Open the subfolder, Your folder, by double clicking on it to be sure all the 
Student files are there. Compare with the instructor’s screen.                                  
. 
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Week 2 
 

A.  Using the keyboard (see figure 1, week 2, page 2) 
 

1. Function keys and Esc key 
These keys are in the top row of the keyboard. The function keys have 
an “F” before the number — i.e., F1 through F12.  Each of these keys 
has a specific function, alone, or in combination with another keyboard 
key.  Here are some examples. 
a. Single click on the desktop.  Nothing happens except that windows 

attention is brought to its desktop. Now press F1 and complete Help 
menu appears. 

b. Go to Programs, Accessories, and click on WordPad. While in 
WordPad press F1. Help appears. Close by clicking on the X. 

c. Press F4 while holding down the Alt key.  The current program will 
shut down and the desk top will appear. 

d. Press F4 while holding down the Alt key a second time.  The shut 
down message will appear. Click cancel.  The shutdown message will 
disappear. 

e. Click on the Start button.  Press the Esc button on the upper left on 
the keyboard.  The Start menu goes away. 

2. Using the Arrow keys (figure 1, right-hand portion) 
a. Single click on the Start button.  Press the keyboard Up arrow.  The 

Turn off Computer word is highlighted.  Continue to press the up 
arrow until Programs is highlighted.  Press the keyboard Right 
arrow.  The subdirectory is highlighted.  Now the up and down 
arrows on the keyboard can select a program lower in the list. Press 
the escape key and then click on an open space on the desktop. 

3. Keyboard shortcuts are described in Help.  
a. Click Start, arrow up to Help and Support. In Search box type 

Keyboard shortcuts, Click arrow or press Enter key.  
b. Choose Windows keyboard shortcuts overview. 
c. Try looking at one of the categories — e.g. Natural 

4. Other special keys will be described when they are used. 
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Figure 1.  Parts of the keyboard. 
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B.  Maximizing and Minimizing Windows 
1. Open and close a window. (figure 2, week 2, page 4) 

a. Click on the Start button. (Note:  you can also press Ctrl+Esc to 
bring the start menu to life (if not seen)). 

b. Slide pointer to Programs. 
c. Slide pointer to Accessories.  
d. Slide pointer to WordPad and click.  Remember – the left mouse 

button is the primary button for right-handed people.  (Note, use a 
single click and press Enter after the icon turns blue or is 
highlighted.)  

e. Click on X in the upper right corner to close the program.   
2. Making a Window fill the screen (figure 2 on page 4) 

a. Load the WordPad program again.  Look at the 3 buttons at right of 
the Title bar.  The left-hand button looks like a minus sign.  The 
right hand button has an X to close the program.  The center button 
has either a single screen icon (maximize button) or a double screen 
icon (restore button).  

b. Click on the center button.  This will either maximize the window 
(full screen) or restore the window.  Click again one or two times. 
(Note:  Double Clicking on the blue area of the Title Bar does the 
same thing.) 

c. Click on the button that looks like a minus sign. This minimizes the 
window and makes it disappear from view — but the program is 
not gone.  It is now placed on the Task Bar at the bottom of the 
screen.  

d. Look for the WordPad icon (document) on the Task Bar and click 
on it.  This restores it to a window. 

 
C.  Adjusting a Window Size (figure 3 on page 4) 

1. Load WordPad 
2. Be sure you are in a window, not a full screen. 
3. To change the window size move the mouse pointer to the right edge 

of the window until you see double pointed arrows.  Hold the left 
button down and drag to the right or left.  Note that the window changes 
size.  Do the same to the top or bottom. 

4. Now move the mouse to the lower right corner of the window, drag 
the double arrow diagonally to change the window size.
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Figure 2.  The three buttons at the far right of the Title Bar 
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The left-most buttons in each view allow the user to minimize the window.  
When the button is clicked, the window will be placed on the Task Bar. It can 
be restored by clicking on its icon in the main part of the Task Bar.  Clicking 
on the middle buttons will restore the view to a window if it is already full 
screen (left-hand view) or make a window full screen (right-hand view). The X 
button is for exiting the window or program. 
 
Figure 3.  Appearance of double arrows for adjusting a window size 

 
  When you move the mouse cursor to 
the edge of a window, it turns into a 
double arrow.  The mouse button is 
then depressed and the arrow is d
in either direction to make the window 
smaller or larger in the dimensio
the arrow (in the illustration (le
upper middle). If the double arrow is 
placed in the corner, dragging it w
change the size of both dimensions.  
Try moving the arrows in both 
directions to see how this works. 
 
 

 
F

A shortcut targets the fold
or file and is recognized by 
the curved arrow at the lowe
left of its icon.  Notice that 
the icon of the folder shortcu
resembles a folder.  The icon 
of file shortcut is a symbol or 
picture associated with the 
program that can open it. 
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D.  Changing a window location on the screen  

1. Load WordPad and find the Title Bar of the WordPad window.  Hold 
the left mouse button down on the title bar and drag WordPad to 
another location on the screen. 

2. Tiling and Cascading windows on the Desktop 
a. With WordPad still open, load Paint and Notepad programs.  On a 

blank space of the Taskbar ( near the System tray) right click. 
b. Choose Cascade by left clicking and note how the three programs are 

placed on the screen. 
c. Right click on the Taskbar again and choose Tiling Horizontally. 

Note how the programs are placed on the screen — each above the 
other.  Tiling Vertically places the programs side by side. 

d. Close all windows. 
 

E.  Using a window’s menu and controls 
1. Load the Calculator program. 
2. Click on View on the Menu bar, which is just below the Title bar. 
3. Click on the word Scientific. 
4. Click on the word Standard on the View menu. 
5. Press  the Function Key F1. Clicking on Help menu does the same thing. 
6. Under the Index tab, scroll down to calculations and then to simple. 

Highlight the word simple and then click on the Display button. (Or in 
the dialog box type SI.)  Instructions on how to do this task appear. 

7. Click on the Search tab and type “dividing” in the keyword box. Then 
click on Enter or single click on list topics.   

 
F.   Filling out forms (Dialog Box) 

1. Click on the Start button and select Run by clicking on it. 
2. Type the word Sesame in the box.  Click on OK.  (After the failure to 

open Sesame message, left click on cancel.) 
 

G.  Working with the Desktop, Start Menu and Taskbar. 
1. Enlarge the Taskbar by moving the mouse to the top of it until the 

double arrow is seen.  Hold the mouse button down and drag the 
Taskbar up.  This allows you to show more open programs easily. 

2. Load Paint, Calculator, and Notepad.  Using the Taskbar icons, click 
on each one individually.  Note the each appears in front and can be 
used. 

3. Find an empty area of the Taskbar with the mouse and drag (hold the 
button down) to the right, left and top of the screen. Put it to your own 
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preference at home.  Drag it back to the bottom of the screen for this 
class. 

4. Hide the Taskbar by right clicking on a blank area of the Taskbar.  
Choose Properties (left click).  Check the Auto hide box.  Click on 
Apply then on OK.  Note the Taskbar disappears.  Move the mouse to 
the bottom of the screen.  Note the Taskbar reappears.  Right click on a 
blank area of the Taskbar.  Left click on properties.  Remove the 
check mark from the Auto hide box. 

 
H.  Using the Start Menu 

Note:  Watch closely while the instructor shows this first. 
1. Choose Search (or Find in Windows 98) from the Start Menu.  Click 

on Files and Folders in the panel to the left.  Type frog in the file name 
box.  Where is it?  Use the scroll bar to find the look in box. Click on 
the little arrow in the “look in” box and click on My Documents.   Now 
click on the Search button.  Double click on eau de Froggie and a 
window appears in the windows picture and fax viewer.  Click on X to 
close. 

2. Right click on eau de Froggie.  Click on Open with.  In the right hand 
menu left click on Paint.  

3. Close the program by clicking the X button at the upper right of the 
window.  Then close the search window. 

 
I.       Using the Desktop. 

1. Making a Shortcut. 
a. Click on the Start button, click on Programs, and Accessories. 
b. Move the mouse pointer to Calculator to highlight it but do not 

Click. 
c. Right click and in the menu, choose Send to and in the next menu 

choose Desktop (as a shortcut).  You should now see a shortcut icon 
to the calculator on the Desktop.  Remember — you can recognize a 
shortcut by the little arrow in the bottom left of the icon.  

d. Double click on the new Shortcut to Calculator.  The Calculator 
program will open. 
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2.  Creating, folders, populating and moving them. 
a. Click on the clear part of the Desktop with the right mouse button.  

Choose New from the menu.  Choose Folder from the New menu.  A 
folder icon will appear with a highlighted caption underneath it. 

b. At the keyboard, type “Junk” and press the enter key. 
c. With the right mouse button drag and drop the Calculator shortcut in 

the new folder you just created.  Read the small menu and click on 
Move here.  Note that the calculator shortcut disappears from the 
desktop. 

d. Double click on the Junk folder.  The Calculator shortcut appears in 
the folder.  Right drag the Calculator shortcut to the Desktop and  
choose Move here from the menu.  Close the empty folder. 

e. Right click on the junk folder.  Choose Delete and answer the 
question. 

J.  Retrieving deleted files from the recycle bin    
1. Drag the Calculator shortcut to the Recycle bin.  The 

Calculator is now in the recycle bin and not on the Desktop...   
2. Double click on the Recycle bin. Right click on the Calculator 

shortcut.  Select Restore.  
Note: When the Recycle bin is open, never choose Empty the Recycle bin 
or Restore all items.  Instead, just click on what you want to remove or 
restore. 

K. Making a  your own shortcut on the Desktop  
1. Open My Documents.  If necessary, move or resize the My Documents 

window so that a clear space on the Desktop is showing. 
2.  Locate your personal folder (the one that has your name on it.   
3. With the mouse, point at your own folder icon and, while holding down 

the right button, drag to the Desktop.  Let go of your mouse button. 
4. On the little menu that appears, choose Create Shortcuts here. 

A folder icon with your name in the caption appears on the Desktop.   
This shortcut looks similar to your folder in My Documents, except that the icon 
has a little rounded arrow showing in the lower left-hand corner.  This is how you 
recognize a shortcut, whether it is a folder or an individual file (see figure 4 on 
page 4)).  
You can make a shortcut to any folder or file by using the steps above.   
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WEEK 3 
Working with Drives, Folders, and Files 

 
A. Understanding File Management 

  
     Office Analogy             Computer Area             What it is? 

File Cabinet               Computer tower  Place to hold drives 
Drawers                     Drives                   Holds files & folders 
Hanging Folders            Folders                          Group of files 
Manila folders               Sub-folders                    Related Files 
Letters, Recipes, etc      Files                               Single batches of info 
 

B. Working with drives. 

1. How to find what is stored on a Drive (Figure 1) 
a. Open My Computer.  Note that several drives are listed and each has an 

assigned drive letter followed by a colon.  The C drive is a “hard disk,” not 
accessible from 
outside the tower.  It 
is always in use when 
Windows is running.  
Other drives may 
have removable d
for example, the A 
drive, CD drives,
The number of dr
varies, depending 
what is installed in 
the computer.  
Therefore, your
computer and your 
home computer may 
differ from the illustration. 

isks, 

 etc.  
ives 
on 

 class 

b. Double click on the A Drive.  Read the error message. 
c. Insert a floppy disk in the 3 ½ slot. 
d. The message should disappear and the A drive window will open.  (If it 

does not, double click on the A Drive.) 
e. Close out the window. 
f. What happens when you start up the computer if you had accidentally left a 

floppy disk in the drive?  
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2. Find how much space is used on a disk (Figure 2) 

Figure 2. This window shows properties of the 
“Student Files” floppy disk. The view was brought 
up by right clicking on the 3-1/2 Floppy(A:) in My 
Computer (Figure 1) and choosing Properties in 
the right-click menu.  As you can see, the files take 
up about 3/4 of the total storage space available in 
the Floppy (A:).  With today’s focus on large 
illustrated documents and digital still and video 
photography, the trusty floppy disk is being phased 
out by many computer companies. CD burners and 
USB storage devices are taking its place. 
Note the tabs at the top.  The Tools tab is 
important and will be covered in Week 7. 

 
a. Open My Computer. 
b. Right click on the A Drive. 
c. Left click on properties. (Explanation of floppy disk size — 1.45 MB or, 

approximately, 1,450 KB or 1,450,000 bytes) 
d. Close out the window. 
e. Open My Computer. 
f. Right click on the C Drive. 
g. Left click on Properties.  Note how much more total space is available, 

compared to the Floppy A Drive.  There should always be ample unused 
space on the hard drive.   

h. Close out the Window. 
3. Deleting a drive. (Cannot be done without a screwdriver.) 

C. Working with Folders   

1. Looking inside a folder (Figure 3, top portion on next page) 
(Note: Beginners should avoid opening the Windows folder listed in the C: 
hard drive as their inexperience may result in problems.) 
a. Open My Documents 
b.  Double click on the Your Personal folder.  Student files folder is now a 

sub-folder to your personal folder. (Note: you may also double click on 
your shortcut on the desktop — see below). 

2.  Different views of files in a folder window (Bottom portion of Figure three 
on page 3 and  Figure 4. on page 4) 
a. Open your Student Files folder and click on the View menu in the Menu 

bar.  Choose the list view and then the details view as shown in figure 4.  
The thumbnail view will show large icons, especially handy for showing 
picture (graphics) files. Try it.  The filmstrip view is an additional option 
when all the files in a folder are graphics. 
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Figure 3.  Looking inside a folder 

 
Above.  The same folder window 
showing the Tasks panel in the left-
hand illustration and the Folders view 
in the right-hand illustration. Among 
other choices, the Tasks panel allows 
you to create a new folder, access My 
Documents, etc. At the bottom, it gives 
Properties of the open folder. When the 
Folders button in the toolbar is clicked, 
the panel changes to Windows Explorer 
so you can see the entire path of the 
open folder (Pine). You can toggle 
back to the Tasks view by clicking on 
the Folders button again.  
Left.  When a folder contains graphics 
files (drawings, photographs, etc.), the 
Panel shows tasks related to this type of 
file.  For example, you can view all the 
pictures as a slide show or select one 
and set it as background for the 
desktop.   The print wizard can be 
accessed by clicking on Print this file, 
which takes you through the steps.  In 
short, the Task panel can be a great 
convenience. 
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Figure 4.  Different views of files in a folder window. 
In addtion to the differences in the left panel views shown in Figure 3., there are 
different views for displaying files in the main folder window.  These are accessed 
by clicking on the view menu in the menu bar or by clicking on the view button, as 
shown in the screen captures below. The Thumbnail view is illustrated in Figure 3 
at the bottom of page three. 

 
 
The list view.  File names, 
with their icons, are listed in 
columns.  If there are too 
many files for one column, 
addtional columns will 
appear and, if necessary, a 
scroll bar will be visible at 
the bottom of the window. 
No details, other than the 
file names, are given. 
 

The details view is very 
useful, giving 
information in a table 
layout.  Size of the file, 
type and date modified 
are shown.  The scroll 
bar at the bottom will 
reveal more information.  
If there are more files, a 
scroll bar will be visible 
at the right 

 
The filmstrip view will be an 
additional option in the view menu 
if all the files in the folder are 
graphics (photographs in this case). 
If one of the thumbnails in the row 
at the bottom is selected, it will be 
shown as a larger preview image. 
Since all of the files are arranged in 
a single row, a scroll bar at the 
bottom is usually necessary.    
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3. Creating a folder in your personal folder (Figure 5 on page 6). 
a. Double click on the shortcut to your folder on the Desktop.  This opens 

your personal folder. 
b. If the window is small, maximize it to show  File and Folder Tasks  panel 

on the left side of the window. 
c. In the File and Folder Tasks panel on the left side of the window, click on 

Make a new folder.  (This feature is not available in Window 95/98/Me) 
d. Type Tree and press enter twice. Now you are looking at the tree folder. 

4. Another way of creating a new folder is as follows:  
a. Right click in a blank area of the Tree folder.  Go to New and in the next 

menu, go to Folder.  Left click and name the new folder Pine. 
b. Repeat the above directions and create a new folder named Stinky in the 

Tree folder. 
c. Drag and drop Stinky to the Pine folder. 
d. Open the Pine folder and verify that the Stinky folder is there. (Figure 5). 

Close out all folder windows.  You now return to the Desktop. 
5. Find Stinky 

a. Click on the Start button. 
b. Go to Search and click on files and folders. 
c. Type Stinky in the name box and choose C: drive in the look-in box.  Then 

click Search button. 
d. Close out by clicking X. 

6. Deleting a Folder. 
a. To get rid of Stinky from the Pine folder, single left click on the Stinky 

folder to select it and then press the delete key on the keyboard. Confirm 
in dialog box with Yes. 

7. Changing a folder name. Click Up folder twice. 
a. Open the Tree folder. 
b. Right click on the pine folder. 
c. Left click on Rename, type Oak. 
d. Move the pointer to a blank area and left click twice. 
e. Exit the Tree folder.  You should be back on the Desktop. 
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 Figure 5.  Two ways of creating a new folder in Windows XP (see outline, page 5) 
 

Method 1.  Right click on a 
blank space in the folder. 
This brings up a menu from 
which New can be selected, 
as shown in the top view at 
the left.  When New is 
selected, another menu 
appears with several choices.  
When Folder is clicked with 
the left mouse button, a new 
folder appears with a caption 
that can be retyped with a 

name of your choice.  This 
method is available in 
previous Windows versions 
as well as Windows XP. 
 
Method 2. Use the Task 
panel as shown in the 
middle view.  By clicking 
on “Make a new folder,” a 
new folder appears with 
highlighted caption as 
shown in the bottom view.  
You simply type over the 
highlighted caption to 
ename it with a name of 
our choice.  

r
y
T
a
9

his method is not 
vailable in Windows 98,  
5, or ME.
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D. Working with files 
1. Opening a file. 

a. Be sure you are on the Desktop.   
b. Double click on Your folder shortcut. 
c. Double click on Student files subfolder. 
d. Right click on the Angry Diatribe file and choose Word Pad.. 
e. Close Word Pad so that the Student files folder is still open. 

2. Copying or moving a file (similar to copying or moving a folder — see Week 
1, p. 9). 

3. Deleting a file (Similar to deleting a folder — see Week 3,C. 6, page 5) 
4. Changing a file name. (Same as renaming a folder) 
5. Showing Extensions of files.  By now you realize that all files have names — 

program or application files usually are named to indicate the name of folder.  
Data files, in general, have names chosen by the user who created them. If you 
look at the files in your Student files folder, they have distinctive names, such 
as Angry Diatribe and Cranky Volume.   
However, filenames also include three-letter extensions, which are probably 
not showing on your screen.  Contrast your folder with the one in the 
illustration below. The file extension indicate what program the file is 
associated with, such as a word-processing document, a drawing or graphics 
program, sound, video etc.     
(Figure 6).  
a. To show file extensions, 

click on Tools in the menu 
bar of the folder and select 
folder options. 

b. Click on the View tab and 
scroll down until you come 
to the line Hide extensions 
for known file types.  
Unclick the square to the 
left of the line and then 
click OK.   

c. Now you should see the 
extensions in your own 
screen. 

Some of the common extensions you may encounter: txt = text file that can be opened 
with Notepad; rtf = Rich Text Format that can be opened with any word processor 
(Word Pad, MS Word, MS Works, etc);  doc  = opens with MS Word, etc.; bmp = 
Bit-Mapped Picture opens with Paint or other graphics program;  jpg = a photo format 
(Joint Photographic Experts Group) useful for email  and Internet; gif = Graphics 
Interchange Format, also useful for Internet but supports only 256-color images; tif = 
Tagged Image File, a high-quality graphics format.   There are many other extensions. 
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E. Working with Floppy disks    

Floppy disks are stiff on the outside but on the inside, they have a thin, flat 
disk of Mylar coated with particles pf ferric oxide capable of holding a 
magnetic field. This is the basis for storing data.  Therefore it is important to 
protect these disks from magnetic fields.  Never put magnets near the computer. 
1. Formatting a floppy disk or erasing data. 

a. Insert a floppy disk, provided by the instructor, into the floppy drive slot.  This 
disk will be colored so as not to confuse it with the black floppy that 
contains Student Files.  (Instructors:  Please be sure to collect both disks 
at the end of this exercise for the next class.) 

b. Go to My Computer. 
c. Check to see if anything is on the disk by double clicking with the left 

mouse button on the 3 ½ inch floppy. 
d. Click on the UP Arrow and go to the next higher window. 
e. Right click on the 3 ½ floppy and then choose Format.  Choose the format 

type and left click on Quick Format to put a check mark in box (note: 
Quick format simply erases all the folder and files on the disk). Click on 
Start.  Read the results. If Errors are indicated, remove the disk from the 
drive and throw it away. 

2. Copying a disk — your own disk (Student files) will be the source disk.  
Please be sure you have your name on the label.  The copy disk will be the one 
you just formatted above (E.1.) 
a. Write-protect your own disk by opening the little window on the back of 

the disk.  The instructor will demonstrate (Figure 7, next page). 
b. Open My Computer.  Right click on the 3½ floppy. 
c. Left click on Copy disk. Insert your own disk (the source disk). 
d. Click start and then follow instructions.  (Note: before inserting, the 

source disk (in this case the black one) should always be write-protected 
so that it is not accidentally erased during the copy procedure.) 

e. When prompted, remove the source disk and insert the copy disk (the one 
formatted above). 

f. When the copy is completed, close the Copy dialog box.  Verify the 
contents of the copy disk by double clicking on the A Drive in the My 
Computer folder.  You should see the Student files folder. 
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Figure 7.  Write protecting a Floppy Disk 
In the views at the left the 
top shows the front of the 
disks with the arrow p
up (this is the end that goes 
into the disk drive). The 
bottom views show the back 
of the disks. In the left hand 
views, notice two small 
square holes, one of which is 
covered.  At the right, both 
holes are open.  This is the 
write-protected mode. 

ointing 

 

  

Below are enlarged views 
showing how to change from 
unprotected (closed) to protected 
(open).  Just slide the little cover 
to the new position. 
 
 

 
 
Figure 7.  Other disks & drives suitable for backing up data 
A CD-R disk is shown on the left. 
If you have a CD recorder (burner) on your home computer, it is a very good way to back 
up your data (including photographs) or to share with others.  It can hold over 400 times 
more than a floppy disk. 

USB storage devices. 
The one shown here at the right is an example of a 
very handy device, called a thumb drive or flash 
memory, which may vary from 64 megabytes   
(44 floppies) to more than a gigabyte (over 700 
floppies). The one pictured is less than 3 inches 
long.  It is easily plugged in and removed, and it can  
be carried on a key chain, in a pocket or as 
a necklace. There are various types of UBS devices   
in the market today. 
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F.  Working with CDs and DVDs  
CDs, or Compact disks, unlike other disks, are not magnetic but rather optical.  
They are read by an optical scanner mechanism with a high intensity light source 
such as a laser and mirrors.  The disk should be handled only by its edges and 
kept free of scratches and dirt.  DVD (Digital Versatile Disks) look about the 
same as CDs on the outside but are capable of holding about 6 times more data. 
Our classroom computers have two drives for two main types of disks, as follows:    

1. CD/DVD-ROM Disks.  ROM stands for Read-Only-Memory, which means 
you can access the data but you cannot transfer or backup data to the disk.  
This type of disk is commonly used for installation of operating systems and 
program applications.   

2. CD-R/RW or DVD-R/RW disks.  R by itself stands for recordable.  RW 
stands for rewritable. With both disks, you can record and add data but with the 
CD-RW disk you can write to the disk many times and so it is ideal for 
backing up updated data. It can also be erased.  With special software, it can be 
prepared to behave like a floppy disk except that it can hold 600 times more 
data. A DVD disk can hold 4.7 gigabytes or about 4,000 times more than a 
floppy disk. 
Using the CD-RW or DVD-R/RW drive and the appropriate disks, you can 
record or “burn” your own disks.  This provides a means of backing up your 
data, saving music, etc.  Backing up data is the important one for our purposes.   
a. Software.  In order to “burn” a CD-R or RW disk, an application program 

is necessary.  Although somewhat limited, a scaled down program is 
included with Windows XP. Later in this course, we will demonstrate this. 

3. Other external storage devices   
a. As described in Figure 7 on the previous page,  USB storage devices have 

become very popular and can be bought in various sizes, from 128 
megabyte to more than a gigabyte.  They continue to come down in price. 

G. Formatting a hard drive.  THIS IS A NO-NO. 
1. This would remove your operating system and all info from the computer’s 

hard drive (usually the C drive).                                                                       



 

Week 4 
 
A. Starting a Program 

1. Opening A Program From The Start Menu    
a. Click once on the Start button 
b. Go to Programs — Opens the sub-menu 
c. Go to Accessories — note the small triangle which means a lower 

indentured menu is available. 
d. Go to System Tools – Some of these items will be covered in Class 6. 
e. Move the mouse to an open area and click once to close the entire 

Program menu. 
2. Opening a program with a shortcut 

a. Covered in Week 2, page. 6, I 
3. Opening a program with a data file.   

A program consists of program files which contain executable 
commands.  In contrast, a data file contains text, numbers, or graphics 
that the user has created using a program, and that program can 
subsequently display the data file.  Examples are documents created 
using a word processing program, graphics created using a graphics-
editing program, etc.   In Windows XP and 98, a data file associated with 
a program can be used to open the program and display the data file.  An 
example: 
a. Open your personal folder by double clicking on its shortcut on the 

Desktop. 
b. Open the Student files folder.  
c. Right click on Joe’s Lament.  A menu comes up as usual with right 

clicking.  Choose Open with. (Figure 1, next page) 
d. Choose WordPad from the Open with menu. Both the program and 

your data file are open.  
 This method saves the steps (B.1. page 3) of first going to the Start menu, 
then choosing WordPad from Accessories, then going to Open in WordPad’s 
File menu, and searching the path to the data file that you wish to open.    

e. Close out of WordPad and any open folders — back to Desktop. 
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Figure 1. Opening a program with a data file. 
  (see outline on previous page, Week 4 A.3.b. and c.) 

 
This view is the result of following the steps on page 1 of the outline for Week 4 (Steps 
A. 3. a. through d.— be sure the words, “Choose Open with,” are added to step c.).  In the 
Student files folder, the file, Joe’s Lament, has been right-clicked, bringing up a menu.  
Open with is selected from this menu and WordPad has been selected in the next menu.   
Both the program, WordPad, and the file, Joe’s Lament, will open by clicking WordPad. 
Special note about the Choose Program option in the right-h
menu above.  The reason for using Open With instead of simply
double clicking on the file, is that it would  open  automatically         
with Microsoft Word or similar word-processor by default unles
WordPad is the only word-processor installed. The default 
association can be changed by selecting Choose Program
Highlight the program of your choice and then click on the little 
box below that says, Always use the selected program to o
this kind of file,” (a *.doc file in this case).  Now you can dou
click to open “Joe’s lament” and it will automatically be 
launched in WordPad.  You can always change back to Microsoft
Word or other word processor by using the Choose Program 
option again. 

and 
 

 
s 
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B.  Opening or Creating a File 
1.  Loading a file into a program 

a. Click on the Start Button. 
b. Go through Accessories to Word Pad and Open it. 
c. Go to the File menu in the menu bar (upper left of window). 
d. Choose Open from the Word Pad file menu. 
e. My Documents should be showing in the Look in box.  If it is not, 

use the drop-down menu and select it. 
f. Double click on your personal folder. 
g. Choose (double click) the Student Files folder. 
h. Double click on the Angry Diatribe file. If it doesn’t come up, go to 

the File Type and select All Documents. Now it should appear. 
i. Close the program.  Now you should be looking at the Desktop. 

2. Creating a File from the Desktop Menu 
a. Right Click on the Desktop. 
b. Choose New from the menu. 
c. Choose Text Document from the menu. Double click on the icon. 

The Notepad program comes up so you can start typing. 
d. Close Notepad. 

 
C. Saving a File   

Note: The first time you save a new document, you must use Save As in 
order to specify location, etc., as in the example below.  The next time you 
save the same document, you may use Save, unless you wish to change the 
location or other settings.  In other words, the Save command will always 
use the settings that you specified the last time you used Save As.  
1. Knowing where to save your work 

a. Double click on your personal folder shortcut on the desktop. 
b. Right click on a blank area of the folder. Choose Folder from the new 

menu. 
c. If highlighted with a blinking insertion point, type Letters over the 

caption and press the Enter key. If it is not highlighted with a blinking 
insertion point, click on the icon and then click on the highlighted 
caption.  Then type Letters as above. 

d. Double Click on the new Letters folder to open it. 
e. Right Click inside the new Letters folder and choose folder 

from the new menu (or click on Make a new folder from the left hand 
panel). Name the new folder Business Letters  

f. Repeat step e and name the new folder Personal Letters.  Close. 
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2. Saving your work — Figure 2, below 
a. Load WordPad from the start menu. 
b. Type the sentence: “My dog has fleas.” 
c. Choose Save As from the WordPad’s File menu. 
d. Choose Your 

personal file from 
the Save In box.  
i. Double click on 

the Letters 
folder. 

ii. Double click on 
the Personal 
Letters folder. 

iii. Be sure File type 
in the Save as 
type box is Rich 
Text Format 
(RTF). 

iv.  Type Doggie in 
the File name box. Click on the Save button.  

v. Our letter appears so we can add to it. 
vi. Type the following to our sentence: “and so does my cat.” 
vii. Go to the WordPad File menu and click on Save or click on the 

Save button.  Note that when you hover the mouse over buttons in 
the tool bar, the name of the button appears. 

e. Close WordPad. 
f. Open Your personal folder.  Double click on the Personal Letters 

folder and verify that the letter has been saved. 
 
D. Sharing Information (that cut and paste stuff) 

1. Selecting information 
a. Load WordPad from the start menu. 
b. Load the file, Angry Diatribe, from the Student files folder in Your 

Personal folder. 
c. Point at the start of the first paragraph. Hold down the left mouse 

button and drag the cursor down and across the screen to the end of 
the paragraph. 
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d. The whole paragraph is highlighted
Note: Shortcuts to 
Highlighting: 
i. A word: Pla

 — Figure 3   

ce mouse 
ble 

ii. h: Triple click 

iii. n 
 

iv.  Hold down Ctrl key and single click in the left 
” 

2. Copying Information 

ribe from Student files. 
agraph. Hold down the 

e 

d. Pad Edit menu. The paragraph goes to a 

e. st line of the letter and 

f. 
 return to previous.   

3. 
aragraph, this time by double clicking on the 

b. t menu. 
 of last line of the letter and click. 

4. am 
in WordPad. 

om the Edit menu. 

cursor on word and dou
click on it. 
A paragrap
with the insertion point 
inside the paragraph. 
 A sentence: Hold dow
the Ctrl key and click on
the sentence. 
A document:
margin. You may also hold down the Ctrl key and press the “A
key. 

a. Load WordPad 
b. Load Angry Diat
c. Point the cursor at the start of the first par

mouse button and drag the cursor down and across the screen to th
end of the first paragraph. 
Choose Copy from the Word
place called the clipboard where it is held. 
Move the mouse cursor to the end of the la
click to put the insertion point there. 
Choose Paste from the Edit menu. 

g. Choose Undo from the Edit menu to
Cutting Information 
a. Highlight the first p

arrow in the left margin. 
Choose Cut from the Edi

c. Move the mouse cursor to the end
d. Choose Paste from the Edit menu. 
e. Choose Undo from the Edit menu. 
Pasting information to another progr
a. Highlight the first paragraph of the letter 
b. Choose Copy from the Edit menu. 
c. Minimize WordPad. 
d. Open Notepad 
e. Choose Paste fr
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f. The paragraph is now part of the new letter in Notepad 
r. 

 
. Printing a File 

inter serves the two computers at each table.  The 
t you 

ter 
 bar. 

 Print button.  After a brief 

2. Ad e next page) 
 you print using the 

b. inter Dialog box.  (These may vary 

in the classroom 

ii. .  Again, these vary according to the 

iii. veral choices — usually the default is the 

iv. .  The default is 1 but you can replace the “1” 

v. ptions are usually available. 

 

g. Click on the Minimize button at the right of the Title ba

E
Remember, one pr
automatic switch tells the printer which computer is trying to print bu
will have to decide who goes first.  
1. Sending information to the prin

a. Bring up WordPad from the Task
b. Click on the Print Preview button. 
c. If the appearance is OK, click on the

delay, the printer will start printing. 
justing the Printer Settings (also se

a. Choose Print from the File menu.  Note that when
printer button on the Toolbar, the default settings will be used, so you 
cannot choose other settings.   
Explanation of choices in the pr
with different printers and with different programs) 
i. Choose the printer.  There is only one per table 

but if you have more than one printer at home, click on the arrow 
and select from the menu. 
Properties or Preferences
printer make and model. 
 Page range.  There are se
whole document. 
Number of pages
with any number.   
Other settings and o
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Figure 4.  Printer settings (see outline for Week 4, Page 6,  E.2.b.) 

The above dialog boxes show settings options for the HP Deskjet 710 printer.  The printer 
was the same but the programs were different — WordPad at the left and Microsoft Word 
at the right.  More options and information are available in Word but the basic settings 
are the same.  First the printer is chosen and its default settings are shown for number of 
copies, page range, etc.  In page range, note that you may select the whole document, one 
or more pages, current page (if more than one page in the document), and selected text.  
The latter is very handy with Web pages, for example, where a single page may take up 
many printed pages.  Just highlight what you want and print out only that selection. 
 

hese views show dialog boxes when the Preferences or Properties button is clicked.  
 

T
Layout to the left and Paper/Quality at the right.  The Advanced button will take you to
even more optional settings. 
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Word processing, Drawing, and Graphics Programs 
 

A. WordPad (Writing a letter) 
1. Open WordPad from the start menu.   

(See Firgure 1 for appearance and location of a. through e. below.) 
a. Title Bar identifies the program you are in. 
b. Menu Bar gives access to commands by clicking on each menu 
c. Tool Bar is an alternative to Menu commands. As you hover the mouse 

cursor over each button, its function is revealed in a little box just below the 
mouse cursor and is also described in a bar at the bottom of the window.  
Try it.  The same is true of the buttons in the Format bar. 

d. Format bar controls the appearance of text. 
e. Ruler is used to change TAB settings. 

 

Figure 1.  WordPad.  This window is fairly typical of a word-processing program, 
e 

ts. 

beforehand.   

although more sophisticated programs offer more features.  The bars at the top of th
window provide all of the commands and formatting tools necessary to create documen
You can even insert objects, such as pictures, provided they are sized and enhanced 
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2. Creating a letterhead with WordPad 
a. Type your name and address, pressing Enter after each line. 

te” and press Enter twice. 

ont size box. Click on the B 

h. 

3. rite a letter. 
rsonal folder. Choose Open with 

c. 
ent name, the Letterhead file will still 

d. 
e. 

ter twice. 
hungry.” 

 pop-down menu and select Arial Black. 

4. 
rom the Edit menu. 

ith box. 

 

b. Press Enter again, type the word, “da
c. Highlight the lines containing your name and address. 
d. Click on the centering tool in the Format Bar. 
e. Click on the Font box and choose 14, click on it. 
f. Highlight your name and choose 20 from the F

button to apply boldface to your name. 
g. Save your work as Letterhead in your personal folder. 

Close the WordPad Program. 
i. Check your folder for Letterhead file.   
Using your Letterhead file to W
a. Right click on Letterhead file in your pe

and click on WordPad. 
b. Choose Save As from the File menu. 

Save the file as Begging in your personal folder. 
Note:  By saving this file with a differ
be available to use again for another letter.   
Double click on the word, date.  
Type today’s date and press Enter twice. 

f. Type “Dear Parents” and press En
g. Type “Please sends me some money. I’m 
h. Press Enter twice and type “Love.” 
i. Press Enter 4 times and type “Robin.” 
j. Save your work. 
k. Highlight the name “Robin.” 
l. Click on the Font
m. Save your work. 
Searching and replacing words in your letters. 
a. Choose Replace f
b. Type the word “Robin” in the find box. 
c. Type the word “Bill” in the Replace w
d. Click on the Replace All button.  
e. Close the program window. 
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B. The Paint Program, (making a 
party flyer). 
1. Choosing the size and color. 

a. Load Paint from the Accessories 
menu. 

b. Choose Attributes from Paint’s 
Image menu. 

c. Set the width to 5 inches.  The 
height to 6 inches and the colors 
to colors. 

d. Click on OK 
e. Save your work as Party Flyer in 

Your personal folder. (Use Save as 
the first time, so you can name the 
file.)  

2. Making a Border. 
a. Click on the rectangle tool.  
b. Draw a rectangle by pointing the cursor 

near the upper left corner. 
c. Hold down the left mouse button and 

drag the crosshairs down and to the 
right. 

3. Adding Color. 
a. Click on the Fill with color tool. 
b. Pick on the color you want to use from 

the color box (right or left click) 
c. Click inside the rectangle. 

4. Adding Text to your banner. 
a. Choose black from the color box  

(left click). 
b. Click on the Text icon which is the 

letter A. 
c. Click on the left side of your page.  If the text toolbar doesn’t jump on the 

screen go to the View menu 
and select it.  

d. Choose Arial from the Font box and select font size of 48. 
e. Left click twice slowly in the top left corner of the colored rectangle. 
f. Drag the text box to the right edge of the Rectangle. 
g. Type Party Time!!! In the Text Box. 
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5. Drawing Circles and Ovals. 
a. Click on the Ellipse tool icon. 
b. Draw an oval (balloon) beneath the banner. 
c. Color the balloon. 
d. Draw a second balloon and color it. 

6. Erasing your artwork. 
a. Click on the Eraser tool icon. 
b. Erase the second balloon you just drew. 

7. Drawing lines. 
a. Click on the Brush tool. 
b. Add a wavy line to the bottom of the balloon. 
c. Save and close program. 

  
C. Image Display and Editing Programs 

Paint is a useful program for drawing but has only limited tools for displaying and 
editing/enhancing digital images, such as photographs, for example.  Graphics is 
the process by which the computer displays data pictorially — thus, an image 
appears on your screen.  Digital photographs have become very popular for 
emailing, printing, posting on Web sites, creating slideshows, etc. So have scanned 
images of old film prints. 
1. Viewing images in Windows XP.  This version of Windows comes with a 

program called Windows Picture and Fax Viewer.  With image files it will 
always be listed in the Open with menu and can be made the default if you 
wish.  Try it on sample photographs. 
a. Open My Documents, open My Pictures. And then open Sample Pictures. 

Note picture tasks in the left-hand panel. 
b. Right click on one of the photographs and open it with Windows Picture 

and Fax Viewer.  (See Week 4 if you need a review of the Open With 
procedure.) 

c. A large view of the photo fills all or most of the screen.  There are tools at 
the bottom of the window, allowing you to zoom in and out, rotate, etc. 

d. Close the Viewer.  In the tasks panel, select View as a slide show.  Use the 
arrow keys to go forward or back.  Press the escape key to close the slide 
show. 
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2. Viewing images in other Windows and non-Windows programs (Windows 
98 also applies here.)  Note:  In Windows 98, you may have to hold down the 
Shift key while right-clicking to bring up the Open with menu. 
a. Paint.  Paint will display photographs and drawings quite well if you click 

on View in the menu bar and select View Bitmap.  Click on the image and 
close Paint. 

b. Internet Explorer will display JPG and Gif files, commonly used for the 
Internet, but not other image formats.  Also, if the files are very large, only a 
portion of the picture will be displayed on the screen.  

c. Irfanview is about the best image-viewer we know of.  It is a free program 
that can be downloaded from www.irfanview.com. It will load just about 
any graphics file, no matter what format, and it is very fast.  We will be 
demonstrating how to download files in Week 6.  If you cannot download it 
yourself at home, please contact one of your instructors. 

3. Image-editing programs.  If you have a digital camera and/or a scanner, an 
image-editing program may have come with it.  Suites, such as Microsoft 
Office and Works Suite, usually include such programs.  We all have our 
favorite programs — Adobe Photoshop Elements, Roxio PhotoSuite, etc.  On 
the classroom computers, we have Picture it! which is included with Microsoft 
Works Suite.   
a. Go to My Documents, click on the My Pictures folder, and open Sample 

Pictures folder. 
b. Right click on Blue Hills and open with Picture It! 
c. Select Levels Auto Fix in the Touchup panel.  This may not be what you 

want, so go to the Edit menu and click on Undo. 
d. Go to the File menu and select Save as.  Click the pop down menu in the 

Save in: box.  Scroll to the top of the menu and click on My Documents.  
Then double click on your Personal Folder.  Click on the Save button.  The 
reason for this step is so that you can make any changes to this photo you 
wish.  The original will still be in the My Pictures folder for other students. 

e. Now try clicking on Brightness and Contrast.  Slide the Brightness and 
Contrast settings back and forth.  Or, click the up and down arrows to the 
right of the slides. Click Done when you have what you want. 

f. Try some of the other editing features, such as changing the blue hills to 
green…………… 

http://www.irfan.com/
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Week 6 

CD Recording, Internet and Email 

A. CD-R/RW Recording 
Please review Week 3, page 10, F. 2.  
1. To copy files and folders to a CD-R 

For this exercise, we will use the software that came with Windows XP.  
It is a limited program but works fine for simple backups/copies of data, 
including pictures, songs, etc.  If you have a CD recorder (burner) at 
home, you may have a better software program — by all means use it.  
a. Using the CD from your book, there is still room for more data to be 

added. Insert in the lower CD drive. Please see Week 1, page 3, 
Figure 1 if you need to review.  Press the little button at the lower 
right of the drive (just above the floppy drive). 

b. Open My Documents from the Desktop and click on your personal 
folder to highlight it.  Do not open it.  While holding the Ctrl key 
down, click once on the My Pictures folder.  Now both folders should 
be highlighted (selected). 

c. Be sure the left-hand panel is showing.  If it is not, change to full 
screen. Under File and Folder 
Tasks, click on Copy the selected 
items.  (If you had selected only one 
item, you would have had a choice 
of Copy this file or Copy this 
folder.) 

d. In the Copy items dialog box, to 
choose where to copy these items, 
select the CD-RW drive (E). Click 
on Copy.   (Figure 1) 
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e.  Open My Computer and double click the CD recording drive. Window 
displays a temporary area 
where the files are held before 
being recorded to the CD.  
Verify that the two folders are 
showing under Files ready to 
be written to the CD.  (Note 
the little arrows pointing down 
on each of the folders icons.)  
                                 (Figure 2)  

f. Under CD Writing Tasks in 
the left-hand panel, click 
Write these files to CD.   
Windows displays the CD 
Writing Wizard.  —     
(Figure 3) Follow the 
instructions in the wizard.   

g.  After the folders have 
been copied to the CD, 
eject it from the recording 
drive by pressing the drive 
button.  (This may happen 
automatically.) 

h. To verify that your folders and files are on the CD, insert it in the 
uppermost CD drive (the “non-recording” drive).  Open the drive (it may do 
so automatically) by double clicking on D: in My Computer. The two 
folders should appear and you should open each one to be sure all the files 
are there. If the disk has not been “finalized,” additional items can be 
recorded at another time until the disk is full. 

2. Alternative Method to Copy Files and Folders to a CD-R 
This method is essentially the same as under A. above but may be easier for 
some users. 
a. Insert your CD, which has room for more data, into the CD recorder. 

This is the lower CD drive.  Please see Week 1, page 3, 
Figure 1, if you need to review.  Press the little button at the lower right 
of the drive (just above the floppy drive). 

b. Open My Computer and double click the CD recording drive. If it opens 
in full screen, restore it by clicking on the middle button in the upper right 
corner. 

c. Open MY Documents.  Be sure both folders are showing. 
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d. While holding down the Ctrl key, drag Your Personal Folder to the CD 
Drive folder and then select copy from the menu.  Do the same with the My 
Pictures folder.  Now the CD Drive folder appears as illustrated in step e. 
(Figure 2) on the preceding page.  Then follow steps f. through h.

Note:  As long as a blank CD-R disk is in CD recorder, virtually any method 
used to copy a file or folder to the CD recorder will work by bringing up the CD 
Writing Wizard — for example, you can use the Send to command (right click 
on the file to be copied) to copy a file or folder to the disk in the CD recorder. 
Then follow instructions f. through h. under A.1. for the rest of the procedure. 
3.  To copy files and folders to a CD-RW 

Please review Week 3 outline, page 10, F.   RW disks allow you to record 
over what are already there and release the space that the original file or 
folder had occupied.  A CD-R does not release the space, in which case, the 
up-dated item will require additional space. A CD-RW costs more than a 
CD-R but may be well worth the extra cost if you are frequently backing up 
updated data.  
To record a CD-RW on the classroom computers, the procedure is the same 
as under A.1. and A,2, 

B. The Internet and World Wide Web  
The Internet was created originally by the US Department of Defense in the 1960’s 
and was expanded by academic researchers in the 1970’s. In 1985, the National 
Science Foundation began a program to establish Internet access for U.S. and 
international educational and research institutions. In the 1990’s, there was a huge 
increase in the number of computers connected to the Internet and it was estimated 
that at this rapid growth, everyone in the world would have an email address by the 
year 2000.  
Basically, the Internet is a huge collection of computers (servers) networked by wires 
and satellites.   
The World Wide Web (www) resides on the Internet. It is a network or collection of 
Internet servers that follow the HTTP protocol and support specially formatted 
documents in the HTML computer language.  These documents are the Web pages 
or Web sites.  To access these sites, A software program, called a Web browser, is 
necessary.  The Web browser allows you to flip through the pages of a Web site or to 
jump from site to site. Windows includes a browser, Internet Explorer.   
Before you can use a browser, Internet connections have to be set up.  Connections 
may be Dial-up though a modem, using ordinary telephone lines, or high speed 
connections, which are many times faster than Dial up.  High speed connections are 
commonly via Cable, Satellite, or DSL.  DSL connections require special telephone 
lines.  
No matter what type of connection you use, you need an ISP (Internet Service 
Provider).  Locally, there are a number of ISPs.  Cable and Satellite companies offer 
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their own ISPs.  For dial-up and DSL, there is a choice.  National providers, such as 
AOL and MSN, may or may not have local phone numbers. If you are using a phone 
line for connection, be sure it is local or you may run up a huge bill.  ISPs will 
provide you with instructions on configuring your connection. In the classroom, we 
are using DSL and our ISP is alink (AlphaLink Technologies). 

C. Internet Explorer (see Figure 4) 
1. To surf the www (world wide web). 

a. Go to Quick launch (on taskbar) or Desktop and click   
on the icon of Internet Explorer — the big E.                                          

b. In address bar, type www.lccsohio.org. Click on Go.  
(see Figure 4 on next page)   

Note: Org stands for organization, Net=Networks, Com= commercial, Gov= 
government, Edu= Education,  
Foreign sites have an abbreviation for their country.  
e.g., UK= England, SP=Spain, etc. 

c. Go to tools and select Internet options 
d. On the General Tab under Homepage address, click on Use Current. 

Click on Apply and OK. 
e. On the new home page, use scroll bar and go to the paragraph beginning, 

“Our general meetings….” The word meeting is in blue — this means it 
is a hyperlink. Note that, as you hover the mouse over the hyperlink, 
the cursor changes from an arrow to a hand.  When you click the mouse, 
you are taken to the Meeting page. 

Note: A Hyperlink takes you to other pages in the same site, or to other Web sites. 
f. In the Address bar, type (your choice).  Check it out!   
g. Then in the Address bar type Google.  MSN Search window comes up.  
h. Go to Google search engine. A Search engine helps you find things 

and information on just about any subject. But beware — not all 
information is correct. Some other search engines are: Yahoo, AltaVista, 
Excite, HotBot, and Lycos, just to name a few. 

i. In the blank Bar, type Maps, click Google search.  On Web Results, 1-
10 of about 132,000.000 hits for the word, Maps.  Click on Yahoo, 
Maps and Driving Directions. Fill out form. In the address bar, type 
“745 E. Main St. Newark, Ohio 43055.” Click on Get Map.  (See 
Figure 5 on page 6.) 

j. Click on Printable Version.  
k. Beside the Back button, click on the small down Arrow to see a menu of 

where you have been.  
l. Click on Licking County Computer Society.   
m. Close Internet Explorer. 

http://www.lccsohio.org/
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Figure 4.  Internet Explorer 
Showing home page of the Licking County Computer Society  

 
This is the view you have in Internet Explorer after you have finished steps C.1. a. through 
e. on page 4 of the Week 6 outline.  At the top of the screen are the usual Title Bar and 
Menu Bar.  Just below these is a Toolbar with buttons specific for Internet Explorer. Hover 
the mouse pointer over each one to find out what it does.  At the far left of the bar are two 
arrows.  The one pointing back is highlighted and, if clicked, will take you back to the 
previous Web page you were viewing. If they are both highlighted, you can go both ways, 
and by clicking on the tiny down arrow between them you can choose any of recent pages 
you have accessed. The Address Bar is just below the Tool Bar. 
 
The two views below the main picture are enlarged views of hyperlinks.   On the left is a 
link to the Meeting page and on the right, links to any page on the site.  Note that the mouse 
cursor changes to a pointing hand when it is over a hyperlink.  
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Figure 5.  Surfing the World Wide Web. 
This view refers to outline for Week 6, page 4, C.1.i. 
 

 
After you have searched for maps in 
the Google search engine and clicked 
on Yahoo Maps and Driving 
Directions, this form appears.  
The address is the location of Zerger 
Hall. In most forms, the tab key will 
take you to the next blank area, or 
you can use the mouse.  Remember, 
wherever you see the little down 
arrow (looks like a v), there are 
choices after it is clicked.  
 
 
 
 

 
 
This is the map that appears after clicking 
on the Get Map button in the box illustrated 
above.  The star shows the location of 
Zerger Hall. You could zoom in to get more 
street names (e.g., O’Bannon) or zoom out to 
see more of Newark , the county, etc. 
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D.  Sending Email in Outlook Express 
1. Open Outlook Express.  

Figure 6 shows the top portion of the screen when Outlook Express is open.  The 
buttons in the Tool Bar have captions below the icons.  The tiny down arrows reveal 
options.  In the left-hand panel are folders for holding email: incoming (Inbox), 
outgoing but not sent (Outbox) and Sent Items.  The view on opening can be changed 
by going to the Tools and View menus. In particular, if the Preview Pane is showing 
when you open the Inbox, be sure to disable it. Go to the view menu and select 
Layout Properties.  In the dialog box, uncheck the box next to “show preview pane” 
under Preview Pane.  Reasons for this are given in the outline (D.1.c.). 

a. Go to Start, All Programs, then to Outlook Express.  Click on it. 
b. When Outlook Express opens, click on Inbox.  
c. Change the preview window. Go to view on menu bar and click on 

layout. In layout window under Preview Pane, click off show preview 
pane, apply and click OK. The reason for doing this is to keep from 
automatically opening a spam email or an email with a virus. 

2. Create Mail  
a. Click on Create Mail to bring up window for new message (Figure 7). 
b. Fill out forms. Address is very important, must be exact — no 

misspelled words or numbers and no extra spaces!  If you misspell part 
of the email address, your message will bounce back to your own 
mailbox, with a confusing undeliverable message attached.  
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Figure 7.  New Message 
By clicking on the Create 
Mail button (left-hand button 
in the toolbar above), the 
New Message window 
appears.  Again, the buttons 
in the toolbar of the New 
Message window are 
labelled.  Fill out the forms: 
email addresses or display 
names from your address 
book go in the To: line. The 
other lines are explained in 
the outline. (Outline, D.2.).  
When you are ready to send 
the email, click on send.  It 
will go to your Outbox and 
will remain there until you 
click on the Send/Recv button 
in the main Outlook Express 
window. 

c. Using the Address Book. One way of preventing misspelled email 
addresses is to save them, with a display name, in the Address Book. If 
you have sent that person an email previously, or have saved senders’ 
email addresses and display name to your address book, click the word 
to next to the address box. A window appears, listing the names of 
people in your Address Book. Select one or more and put it in To, Cc 
or Bcc.   

d. Explanation of the “copies.” Cc. stands for carbon copy. In other 
words, all the people whose names are put here will receive the same 
message, and their names will appear in the email.  Bcc. Stands for 
Blind carbon copy, names will not be on email. 

e. Using the Tab key, go to the Subject line.  The subject line should 
always be filled in. Just a short word or two is all that is needed. It 
helps your recipient know what your email is about so that he or she 
can choose to respond right away or file it in the “I’ll respond when I 
get around to it” box.(It may also distinguish it from spam.) 

f. Click on Tab and the I bar is in message area ready for typing.. 
g. Attachments.  Documents and photos may be sent in the email 

message. Just click on Attach and a window comes up, in look in box 
click on your folder. Choose Froggie, click on attach and it is on your 
email. 

h. Click on the Send button when finished and it will go to the Outbox.  The 
next time you click on the Send/Rec button, it will be sent to the 
recipient(s). 
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Note:  If you ever receive a message with an attachment that ends in the letters EXE or 
VBS, please delete the message immediately without opening it — even if the message 
comes from a trusted friend. Those attachments are the easiest way for evil people to 
send virus and worm programs into computers. After these programs get into your 
system, they replicate, sending copies of themselves to everybody you know-all you 
friends-without you knowing what’s going on. For complete peace of mind, buy an 
antivirus program and keep it updated faithfully. (This is taken from Windows XP for 
Dummies by Andy Rathbone.)  
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Week 7 
Maintenance, Trouble Shooting, Updating and Backups 

in Windows XP  
A. Review of  Week 6  

1. Internet and Email — question and answer period 
B. System tools To get to System Tools, open My Computer, right 

click on the C: drive, and click on Properties.  The properties 
window appears as General — see tabs at the top of the window just 
below the Title Bar. 
1. Disk Cleanup (Figure 1). 

a. Click on the Disk Cleanup button; the Disk Cleanup window 
appears.  It has a list of folders containing files that may be 
deleted if you wish.  Each item in the Disk Cleanup list is 
followed by the number of kilobytes that will be gained by 
“cleaning” it, and the total is shown below the list.  Generally, it 
is safe to choose all of them but you may also be selective. By 
highlighting each one, either a View Files button or information 
about the item appears below the list. ( As you know, you may 
also delete files from the Recycle Bin easily from the Desktop.)  

b. Click on OK. A message appears. Click on Yes if you still wish 
to delete files in the selected items. 

c. Now you are back to the Properties window. 
2. Tools — Two tools appear when you click on the Tools tab. 

Note: Those running Windows 98 or 95, should use the Windows 
98 Course Outline at home. If you did not get one, there are extras 
on the shelf.  Please ask the instructor. 
a. Error checking.  Click on Check Now.  

i. Under Check disk options, click on the box for 
Automatically fix system errors and then click Start.  

ii. A message window appears 
saying “You do not have 
sufficient rights to check 
this drive.” Click on OK to 
close the message.  
The reason this happened is 
that your user account is limited. Only the Administrator can 
do this – at home, if you are the only user, you are the 
administrator), and you will be able to complete the step.  
The rest of the steps for Error checking are illustrated in 
Figure 2. 
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 Figure 1.  Disk Cleanup  (see Week 7 outline, page 1, B.1.) 

 

 

When the OK button is clicked, a 
message comes up making sure 
you want to proceed with this step.  
Click Yes to do it.    
Also see Outline for Week 7, page 1. 

Above, left:  Properties window of the C: 
drive.  To get to this screen, right click on 
the C: drive in My Computer.   
By clicking on the Disk Cleanup button, 
the Disk Cleanup window (above, right) 
appears. It contains a list of items that can be 
emptied if the little boxes to the left of each 
is checked.  The number of kilobytes that can 
be saved is listed on the right. Highlighting 
one item at a time reveals information under 
Description.  With some, it is possible to 
view a list of files inside the folders. 
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Figure 2.  Tools — Error checking 

 

 

 

 

 

 

When the Tools tab is clicked in the Properties Window (upper left on the previous page), 
the view at the upper left appears.  It has the two tools for Error checking and for 
Defragmentation. Here, the Error checking is selected by clicking on the Check Now button.   
Another dialog window appears, with two options.  The one for automatically fixing file 
system errors is checked.  The second option is a surface check to find and attempt to recover 
bad places on the hard drive.  Usually, this is not necessary unless physical damage to the 
disk is suspected.  When the start button of this window is checked, the scan is started, but 
then a message comes up (the lower illustration).  As you can see, it wants to schedule the 
rest of this procedure for the next time the computer is rebooted.  Click yes. 

The reboot does not have to be done immediately, but should be completed before using the 
Defragment tool.  (See next page.) 
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b. Defragmenter tool (Figure 3) 
Disk Defragmenter consolidates fragmented  files and folders on 
your computer's hard disk, so that each occupies a single, 
contiguous space on the volume. As a result, your system can gain 
access to your files and folders and save new ones more efficiently. 
By consolidating your files and folders, Disk Defragmenter also 
consolidates the volume's free space, making it less likely that new 
files will be fragmented. (From Windows Help) 
It is always wise to use Disk Cleanup before Defragging.   
You should be back at the window with the tools tab active before 
beginning the steps below.   

i. Click on Defragment Now button to bring up the Disk 
Defragmenter window.  

ii.  The C: drive should be selected (highlighted). Click on the 
Defragment button near the bottom of the window. 

iii. Again, a message comes up 
that you are not allowed to 
defragment a volume. Click 
on OK. 

iv. Please look at Figure 3 on 
page 5 for a description of subsequent steps.  

v. Exit out of the Properties window to go back to the Desktop. 
How frequently you run the tools described above depends on how often and 
what kind of programs you use.  In general, if you use your computer almost 
every day, it is wise to check for errors and to defragment every month, or 
more often with heavy use.    

C. Windows Update — (Figure 4) — It is a catalog of items such 
as drivers, security fixes, critical updates, the latest Help files, and 
Internet products that you can download to keep your computer up-to-
date. In Windows XP, updates are always available on Microsoft’s 
Web site.   
1. Automatic Update. 

Unless you have turned off Automatic updates, critical and 
security updates are downloaded after Microsoft scans your 
computer to generate a list of critical updates.  It is done in the 
background whenever you are online.  This is when you may see a 
“balloon” message in the system tray (notification area) telling you 
that updates are ready to install.  You can view the updates first, if 
you wish.  There are optional settings for this feature. (You have to 
be administrator to do this.) 
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Figure 3.  Defragmentation   
(see outline for Week 7, page four, 2,b.)   
This view at the left appears when the Tools 
tab is clicked in the Disk Properties window.  
After the error checking has been completed, 
click on the Defragment Now button. The 
views below appear. 
The middle view shows the Disk 
Defragmenter window before beginning the 

procedure.  Choose 
(highlight) the disk you 
wish to defragment. Note 
the two blank horizontal 
bars. Click on the Analyze 
button. When this finishes, 
the report is shown 
graphically in the upper of 
the two bars (see 
illustration below). Now 
click on the Defragment 
button. By watching the 
lower bar, you get an idea 
of what Disk 
Defragmenter is doing. 

Each vertical line  has a 
color corresponding to the 
code at the bottom (cannot 
be seen in your black and 
white copy). They begin to 
be moved around.  The 
procedure may take a while 
so you don’t have to watch 
it.  After defragmentation is 
complete, the view is quite 
different. Not only have 
files been defragmented but 
the free space (white) has 
been consolidated for future 
(unfragmented) files.     
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Figure 4.  Windows XP Updates — optional settings 
 

 
Upper left-hand view.  After you have right clicked on MyComputer and 
selected Properties, the System Properties window appears. From the tabs at 
the top of this window, Automatic Updates tab is selected.  Microsoft 
recommends the setting that gives you no choice — i.e., available updates 
for your computer will be downloaded and installed automatically.  
Upper right-hand view.  The next two options give you a chance to decide 
whether or not to install the updates.  A good choice, if you want control 
over the updates, is the third option. You would be notified when updates are 
availble for download and installation but it will not be done automatically.   
The fourth option is to completely disable Windows Update.  Since many of 
the updates are for added security, this is risky. You should then go to 
Windows Help and Support and click on Windows Update at regular 
intervals.  You will be taken to Microsoft’s Windows Update Web site 
where your computer will be scanned for available updates.  You can then 
choose from a list of updates for download and installation. 
Service Pack 2 is an impoprtant update for Windows XP.  It should not be 
downloaded and installed automatically for two reasons.  First, it is very 
large so you may wish to get it on disk.  Second, there are guidelines for 
preparing your computer before installation.  
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a. Right click on My Computer and select Properties.  Click on 

Properties. 
b. Click on Automatic Updates in the tab at the top of the Systems 

Property window.  Click the option you want: 
i. Automatic (recommended).  The updates will be 

downloaded and installed in the background.  No 
notification.   

ii. Download updates for me but let me choose when to install 
them.  You are notified when updates are ready to install. 
You may view them and select specific updates that you 
want to install.  This is a good compromise. 

iii. Notify me but don’t automatically download or install them. 
Windows finds updates that apply to your computer but does 
not download or install them until you select ones that you 
want.   

iv. Turn off Automatic Updates.  In order to get updates with 
this option, you should go to the Help and Support Center in 
the Start menu and click on Windows Update under Pick a 
Task.  You will then be taken to Microsoft’s update Web 
page where you may scan for updates applicable to your 
computer.  This method is more time-consuming and puts 
the responsibility on the user. 

2. Service Packs 
In addition to regular critical/security updates, Microsoft releases 
larger updates called Service Packs, which contain all the fixes and 
enhancements made available during the previous year.  The 
Service Packs may also contain other improvements so they may 
be quite large.  Thus, Microsoft offers free CDs if you do not wish 
to download them.  There have been two releases for Windows 
XP. In both cases, the Service Pack can be uninstalled later, 
provided you opted for archiving the files during installation.  This 
is important, so be sure you have lots of space on your hard drive. 
a. Service Pack 1 was released first and is included with Windows 

XP on the class computers, which were new in June, 2004. 
b. Service Pack 2 is the most recent release and has been 

somewhat controversial but currently most problems have been 
resolved by guidelines to be followed before you install.  
See www.microsoft.com/windowsxp/sp2/default.mspx and 
click on “What to know before you down and install.  New 
computers (since fall of 2004) already include Service Pack 2. 
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D. System Restore 
As with other system tools in Windows XP, this one requires 
administrator privileges. If something goes wrong, System Restore 
allows you to go back to an earlier time without losing any data files.  
It is discussed in your book, Chapter 15, and in Windows XP Help. 
Just search for System Restore.   It is a limited utility but is very 
useful when it works. 

E. Spyware &Adware 
From Webopedia: (n.) Any software that covertly gathers user 
information through the user's Internet connection without his or her 
knowledge, usually for advertising purposes.   
And from Spybot’s Dictionary: What is spyware? In easy terms, 
spyware is software that transmits personally identifiable information 
from your computer to some place in the internet without your special 
knowledge. Adware is also often a side-effect of spyware, as both 
monitor you for a sole purpose – delivering you advertisement that is 
especially tailored to your habits. 
No matter what the definition, if you have adware or spyware on your 
computer, you need to get rid of it.  How do you know if you have it? 
And how do you get rid of it?  Both questions are answered by two 
programs that can be downloaded from the Internet.  Lavasoft Ad-
Aware and Spybot Search & Destroy.  
http://www.spybot.info/en/index.html  Spybot is freeware, although 
donations are accepted. 

F. Antivirus Protection 
Viruses can wreak havoc with your computer.  It is essential to run 
reliable and up-to-date antivirus software.  Many new computers 
come with trial versions that last only three months or so. 
Furthermore, it will not be up-to-date for protecting against recent 
viruses until you go on line and update the virus definitions. The same 
applies to buying a new antivirus program.  Whatever antivirus 
program you use, it should have auto-protect and automatic 
LiveUpdate enabled.  Check the date of virus definitions frequently. 
This description uses the terminology of Norton Antivirus but any 
antivirus program should have comparable features.  You should scan 
for viruses at regular intervals. 
Grisoft AVG antivirus software is highly-rated and is free for 
individual users. To find it, search for AVG in Google search engine 
(www.google.com).  
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G. Some general guidelines 
1. Always place (save) data files in My Documents, using personal 

subfolders that you have created. 
2. “Clean up” the hard drive, frequently, as described above.   
3. Always use the Error-checking and Defragmentation tools prior 

to installing any large programs. 
4. Keep your antivirus software up-to-date, as described above, and 

scan your computer frequently.  It is a small price to pay. 
5. If you have data files you do not want to lose, back them up! – 

i.e., save or copy them to a floppy disk, zip disk, CD, or other 
external media.  And if you have important data, take the 
removable media off-site.  If you are writing the Great American 
Novel and you have a house fire, you do not want to lose that 
information.  Consider saving more than one copy of your 
important data. 

6. Avoid the urge to install every piece of software that comes your 
way, especially questionable or unknown shareware/freeware.  Be 
sure any software program you do install comes with uninstall 
software. 

7. Use Windows or Program Help when you encounter a problem. 
8. When all else fails, contact LCCS — instructors, Windows SIG, 

and Repair SIG should be able to help 
 

 
We would love to welcome you as new members of the 

Licking County Computer Society. 
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